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Nuix Imager User Guide

Nuix Imager is a standalone application that acts as a powerful forensic imaging tool. Nuix Imager allows
you to create images from files and folders and networks to cloud repositories such as email accounts,
Microsoft SharePoint, Dropbox, Google Drive, Amazon S3, and many more; and to preview and triage
evidence sources so only relevant data is captured.

User features

Use Nuix Imager to:
® Create forensic images of all the data sources Nuix Workstation is able to process
® Create images from files, folders, and networks to cloud repositories such as email accounts,

Microsoft SharePoint, Dropbox, Google Drive, Amazon S3, and many more
® Export evidence in a number of ways

Application features

Nuix Imager:
° Collects data from multiple sources, including hard drives, files, email servers, and cloud storage
o girp\)/[lai)er?s all platforms that Nuix Workstation supports: Windows, macOS, Linux

®* Runs in a portable mode, such as from a USB flash drive, on either a Windows or a Linux machine
® Runs in a non-portable mode on either a Windows or a macOS machine

License requirements

Acquire licenses from a dongle attached to the same machine, or from a remote license server.

For a list of licenses that you can use to run Nuix Imager, see Licence Profiles.
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Install Nuix Imager

This section covers how to do the following:

- Install Nuix Imager on portable versions (either on a Windows machine or a Linux machine)

- Install Nuix Imager on non-portable versions (either on a Windows machine or a macOS machine)
- Install the associated add-ons (FFmpeg and FFprobe and, if required, the IBM (Lotus) Notes Cient)
- Check for missing dependencies via System Diagnostics

- Uninstall Nuix Imager (if required)

Nuix Imager is in two versions:
- A portable version: Available for Windows or Linux OSs, this can run without being installed.
- A non-portable version: Available for macOS or Windows OSs, you must install this on a local machine.

If upgrading your version of Nuix Imager, you do not need to uninstall a previous version, as the installer
package automatically overwrites any previous version when installing the new version. (However, if for a
reason other than upgrading your version of Nuix Imager you would like to uninstall and remove the
product, then see the relevant 'Uninstalling Nuix Imager' procedure at the end of this section.)

If you experience any issue with installing Nuix Imager in either portable or non-portable versions, refer to
Troubleshooting issues for detailed information on how to attempt to resolve the issue.

Install on portable versions

In addition to being a standalone application, Nuix Imager can be run directly from a USB drive or any
portable device to collect evidence. When Nuix Imager is launched in portable mode, you are prompted to
select the license before proceeding.

Install on a Windows OS

To set up and use the portable version of Nuix Imager on a Windows machine:

1. From the Nuix Customer Portal, download the portable bundle for Windows.

2. Unzip the contents of the downloaded ZIP archive to a USB drive or any portable device.

3. To configure the locations used for logs, temp files, and user data, open the portable-config.
properties file located within the root of the archive.
By default, portable-config.properties is configured to redirect all data into a directory named
portable-user-data, which exists in the portable bundle.

Install on a Linux OS

To set up and use the portable version of Nuix Imager on a Linux machine:

1. From the Nuix Customer Portal, download the portable bundle for Linux.

2. Extract the contents of the downloaded tar gz archive to a USB drive or any portable device.

3. To configure the locations used for logs, temp files, and user data, open the portable-config.
properties file located within the root of the archive.
By default, portable-config.properties is configured to redirect all data into a directory named
portable-user-data, which exists in the portable bundle.
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portable-config.properties

The settings in this file manage the paths to store the data.

Setting Description

user-data- Redirects all user data (metadata profiles, settings,

directory and so on) to the specified directory.

log-directory Redirects all logs to the specified directory.

temp-directory Redirects all temporary files to the specified
directory.

redirect-all Redirects all user-data, logs, and temporary files

to the specified directory.

Install on non-portable versions

The non-portable version of Nuix Imager is available in two ways:
- As part of an installation of Nuix Workstation on a local machine
- As a standalone version on a local machine

Install on a Windows machine

Example

user - dat a-
di rect ory=port abl e-
user - dat a

| og-directory=l ogs

tenp-directory=tenp

redirect-all =port abl e-
user - dat a

To set up and use the non-portable version of Nuix Imager on a Windows machine:

1. From the Nuix Customer Portal, download and open the Nuix Imager Installer package.
2. Accept the license agreement and click Install to start the installation.

The progress bar appears, showing the status of the installation.
3. Once the installation is complete, click Finish to exit the wizard.

Install on a macOS machine

Nuix Imager for macOS is provided with a 64-bit installer for all license types. Once you install the

hardware and any prerequisite software, you can install Nuix Imager.

To install Nuix Imager on a macOS:

1. From the Nuix Customer Portal, download and open the Nuix Imager Installer package.
2. Accept the license agreement to start the installation with default options.

The installation progresses and the Nuix application icon appears.

3. To complete the Nuix Imager installation, drag and drop the Nuix icon into the Applications folder.

Nuix Imager is now installed successfully.
4. To open it, double click Nuix in the Applications folder.
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Install add-ons

Add-ons for Nuix Imager include the FFmpeg and FFprobe add-on, and the IBM Notes Client.

Install FFmpeg and FFprobe add-on

To install the FFmpeg and FFprobe add-on:

1. Download and open the FFmpeg and FFprobe package.
The zip file contains FFmpeg, FFprobe, licenses, and README files.
2. Copy the FFmpeg and FFprobe files to one of the locations in the following table:

Operating System Copy Location
Windows Program Files/Nuix/Nuix <x.x>/bin

macOS - Jusr/local/bin or the default location for MacPorts -/opt/local/bin.
Linux - lopt/local/bin

Install IBM Notes Client

IBM (Lotus) Notes Client (x86), v8.5.3 or v9.0 is required for processing encrypted IBM Notes archives.

Check dependencies via System Diagnostics

When Nuix Imager is started for the first time, the System Diagnostics window appears. The
Dependencies tab shows whether or not the prerequisites are installed.

1. Review this list to ensure that all of the expected prerequisites are installed.

For each dependency not found, the following prompt appears: | understand the consequences of

lacking this dependency.
2. To confirm that Nuix Imager should run without these dependencies, select them individually, and
click OK.

See Troubleshooting issues for more information on how to use the diagnostic information on this window.

Uninstall Nuix Imager (if required)

You do not need to uninstall Nuix Imager before upgrading to a newer version of the application. If you
need, for any reason, to uninstall this application, follow:

Uninstall on a Windows machine

To uninstall Nuix Imager on a Windows machine:

1. Navigate to Start, select Control Panel and then Programs and Features.
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2. From the list of programs, select Nuix Imager x.x and click Uninstall.
3. In the confirmation message that appears, click Yes.
Nuix Imager is successfully uninstalled.

Uninstall on a macOS machine

To uninstall Nuix Imager on a macOS:

1. Open the Finder, and navigate to the Applications folder.
2. Find Nuix Imager and drag it to the Trash can.

Alternatively:

Open the Launchpad and find Nuix Imager.
Click and hold the icon until it starts to wiggle.
Click the X that appears in the upper-left corner.
Confirm the deletion in the window that appears.

PR
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Start Nuix Imager

This section covers how to do the following:

- Start Nuix Imager with a physical dongle

- Start Nuix Imager with Cloud License Server
- Reset the User Account password

Start Nuix Imager with a physical dongle

To start Nuix Imager:

R A

7.

Ensure that Nuix Management Server is installed on you machine.
Insert the Nuix dongle into an available USB port.
Navigate to Start and select Control Panel > Administrative Tools > Services.
In the Services window, select Nuix Server and click Start to start the service.
Navigate to Start > All Programs > Nuix and double-click Nuix Imager to start Nuix Imager.
In the Licence Selection window, select:
a. The license source and enter valid login details.
b. The type of license to run if there is more than one type available.
Click OK for the Nuix Imager home page to appear.

If Nuix Imager does not successfully start, access the logs at: %localappdata%\Nuix\Logs or contact Nuix
Support at https://nuix.service-now.com/support.

Start Nuix Imager with Nuix Cloud License Server

Nuix Cloud License Server is a global license server that integrates with Nuix Imager. It provides an in-
house licensing solution run on Amazon Web Services (AWS). When Nuix onboards you an end user, you
are given a License user account. If you have not received yours, contact Nuix Support.

To start Nuix Imager using Nuix Cloud License Server:

B Start Nuix Imager.

For example, on a Windows computer, open the Nuix Imager <X.X> application.

® |n the Licence Selection window, select the cloud license server (https://licence-api.nuix.com/).
® |n the Login window, enter your user name and password, and then click Login.

Select where to get your licence from:

https:/flicence-api.nuix.com/ (doud-server)

Login X

Select the type of licence you want: Login to licence-api.nuix.com/52.20.73.250:443

User Name  |Username

Password | sesssssses|

Select how many workers you want: Forgot your password?

Mumber of workers: 0f= Cancel

OK Cancel
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= Select the type of license and click OK. Then:
- For worker-based licenses, ensure you select at least one license worker.
- For user-based licenses, you do not have the option to choose the number of workers.

Select where to get your licence from:

https: /flicence-api.nuix.com (doud-server)

192,168, 133, 1:27443 (Server)

[fe80:0:0:0: 74dd: cdfa:ce06:976e] : 27443 (Server)

ausyd-s-supcls 2, nuix, com: 27443 (Server) W

Select the type of licence you want:

Muiix eDiscovery Workstation

MNuix Email Archive Examiner (250 available)

Muix Investigation and Response Approximate Remaining cap: 3 bytes

Muix Incident Response v

Select how many workers you want:

a

MNumber of workers: 45 (466 available)

III Cancel

The Nuix Imager home page appears.

e [ Image MobleDevice [ SaveAs ) ExportDiskimage [ ExportLogical image [} Compute Digests @ Venify Image

Evidence Tree & B X Chiden & 8 X ltem

a|m view: [Resutstst v| | Tz Text | B Natve | Metadata
inery | Native

[ Quick metadata only ~ Detals Jines v

Name MIME Type Path Name: Audted | created: Author:
Last modified: Company:
Last accessed: Keywords:

Title:

3 >

Items Selected for Export

Reset the user account password

To reset the user account password:

1. Reset your user account password using any of the following methods:
® Cloud License Login Server: Log into CLS Login Server and click Reset password.
®* Nuix Workstation: During the license selection process in Nuix Workstation, click Forgot
your Password? in the Login screen.
® Nuix Imager: If you are signed out of Nuix Workstation and open Nuix Imager, during the
license selection process, click Forgot your Password? in the Login screen.
2. In the Reset Password screen that appears, enter your user name and click SEND RESET
PASSWORD LINK.
The reset password link is sent to your registered email account.
3. Access the link and reset your password.
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User interface

This section details the main components of the Nuix Imager interface. As indicated by the numbers in the
following image, they comprise:

Evidence Tree pane
Children pane

Item pane

Items Selected for Export
Status bar

aghrwNE

0
File Edit ftem Eport Help
0 AddEvidence... = Remove Evdence (] Inage Mok bieDevie [ Save As [ Export Dskinege [ ExportLogcalimage ) Compute Digests. @ veriy inage
28X lem a8 x
10 R Looced 2 htems & EMC EnaiXtender Pan Pont oot

Text [ Brary | Native | Metadata

» Detais e v

MIVE Type Path lane.
Diectory EMC Emaitender Pain Point potx Tme
= T D0 you wish that you coud getresuts/ansiers faster?
EnaiXtender's search functon s notoriusly sow
1005, Frot

<o

nd training.

Vihy NUIX s better
Search Results come back in seconds o minutes a5 opposed fo hoursor days
Search - by the nunber of search termsor the number of s,
nt

e results from two dentical searches

ol textindex.

restarted from the begiming.

Items Selected for Export @8 x

o) _—

From this screen, you can remove, rearrange or resize evidence, using any of the views to better suit your
needs.

To return the views to their default layout, select Reset Layout from the File menu.
The menus and tabs provide you with more detailed and granular access to the user interface. Once

evidence is added into Nuix Imager, preview and triage the content to eliminate any irrelevant evidence
and curate the evidence to be exported.

Evidence Tree pane

The Evidence Tree pane lists all the evidence added. Navigate through the evidence and select the
required item. The selected item's details are populated in the Children and Item panes.

Select to sort the evidence tree in one of the following ways:
® Unsorted: To list items in their original order, where possible.

® Sorted: To list items alphabetically.
® Sorted containers first: To list evidence alphabetically, with containers at the top of the list.

User interface 9



Children pane

The Children pane displays the contents and details of evidence containers added to Nuix Imager. The
files and directories displayed are determined by the items selected in the Evidence Tree pane. Results
appear in a list form by default, but if a directory contains images, change the view to an image gallery to
review the contents of the images.

To change the view in the Children pane:

1. Click the View drop-down list.
2. Select either of the following views:
® Results List: To display results as a list that includes item metadata.
The option to view Quick Metadata Only displays only basic metadata of the selected items.
®* Images: To display only images contained in the containers. All other files or containers are
hidden.

Find descendants of the items by clicking . It calculates and displays the number of child items loaded.

ltem pane

The Item pane comprises of information and tools that allow you to view the item itself, the metadata
associated with the item, and additional information to help analyze the context of the item.

It displays the complete, hierarchical path that shows all parent items for the item being previewed. You
can view the items in the path by clicking any folder link, which opens a new result set. The Item pane
includes the following tabs to present different views of the item's content and associated metadata:

Text

Binary

Native

Image (only appears if the item previewed is an image)
Metadata

Text tab

This tab displays the extracted text of the item and details about the item and is selected by default. Click
Details to show or hide a subset of the metadata processed for the item, based on MIME type.

Use the drop-down list at top right to view a summary of the text, a selected number of lines, or the full
text. Your selection is remembered when you view the next item.

Binary tab

This tab displays the hex and allows you to search the raw data structure at a binary level. This tab
provides options that allow you to decode values recovered from unsupported file types and file fragments
or unknown binary files.

Select the required data decode format from the drop-down list at the bottom of the pane, and then select
the first byte to interpret the complete data field.
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Binary Templates

Nuix Workstation supports highlighting and decoding binary data using binary templates stored in the user
data directory. For example, a decoded Apple Partition Map can be highlighted in the template as:

cl ass Appl ePartitionEntry < Bi nData:: Record

endian :big
string :magic, :length => 2, :colour => $magi c_col our
uint16 :reserved, :colour => $reserved_col our
uint32 :partition_count, :colour =>"'#74A1C1"'
uint32 :partition_start, :colour => $offset_col our
uint32 :partition_size, :colour => $size_col our
string :partition_nane, :length => 32, :colour => $nanme_col our
string :partition_type, :length => 32, :colour => $type_col our
uint32 :start_sector, :colour => $offset col our
uint32 :data_size, :colour => $size_col our
uint32 :status, :colour =>"'#93FFEQ'
ui nt 32 : boot_code_start, :colour => $offset_col our
ui nt 32 : boot _code_si ze, :colour => $size_col our
string :padding, :length => 0x19c
end
Item a
|4 apm-deleted-entries.dd
Text” Binary Native Metadata
000la0 | 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00  -----v-v-vvov-n-
0001b0 | 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00  -----v-v-vvoven-
0001cO | 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00  -----vvvvenvenns
0001do | 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00  -----vvvvcvvenns
0001=0 | 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00  -----v-vvovvenn-
0001f0 | 00 00 00 00 00 00 00 00 00 00 00 00 00 00 S5 AR -------------- 1]
[50_4pfoo oo} 80.06]00 00 00 01]00 00 0o 3F| P el --1---3
41 70 70 &C €5 00 00 00 00 00 00 00 00 00 00 00 Apple-----------
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00  -----c-v-vvvn---
41 70 70 6C 65 SF 70 61 72 74 €9 74 69 6F 6E SF Apple_partition_
6D 61 70 00 00 00 00 00 00 00 00 00 00 0O
|oo 00 00 oofoo 0o 0o 3F[oo 0o oo oofoo oo
00 00 00 00|00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00

Matching

If a matcher is registered as part of the template definition then the highlighting is automatically applied
when an item is viewed in the binary view. Matching can be done against the binary directly, or against the
source data item being viewed.

A binary based matcher(for NTFS file records)

regi ster_matcher ->(matcher) {
if (matcher.ascii (0, 4
return NtfsFil eRecord. new

end

User interface
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A context based matcher (for GPT partition tables)

regi ster_matcher ->(nmatcher) {
if (matcher.mne_type == '"application/x-disk-imge' &&
mat cher. get _property(' Partition Table Type') == 'EFl PART')
return GptPartitionMap. new
end

}

Decoding

Once a template is selected, it is applied to the binary to decode it. The decoding syntax is based on the
Ruby bindata gem, and it loosely has three parts for each template structure: the declaration, the
endianness, and the fields.

class The template declaration. It creates a new template so it directly extends from
Nt fsFil eRecord < BinData::Record, although it is possible to have a common base template (see
Bi nDat a: : Record NtfsAttributeCommon in NTFS.btpl).

endian :little Sets the endianness for the template.
NTFS, an x86-based format is little endian, but some Mac and Unix formats
are big endian.

string :magic, : The field declarations, which start with a field type, then a name prefixed with a
length =>4, : colon. For example, :usn. The remaining parameters are usually optional but
col our => can include the color to apply to the field, and a description for the tooltip text.
$magi c_col our

uintl16 :
fixup_of fset,
col our =>
$of f set _col our

uint16 :
fi xup_count,
col our =>
' #93D2FF'

ui nt 64 :usn,
col our =>
$usn_col our,
description =>
' Updat e sequence
nunber’

uint16 :
sequence_nunber,
:col our =>
' #93D2FF'

end Closes the declaration.

Native tab

This tab uses a native viewer (external application) to view the selected item. Using the native viewer is
disabled by default, so the selected item will not load. To enable it, click Show Preview Options. Once
enabled, the item appears by the external application. The Launch button in the preview pane is also
enabled.
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The Native tab currently supports the following native viewers:

Program

- Microsoft Office
- Office viewer
programs

- Open Office

- Libre Office

Microsoft Visio

Microsoft Project

Microsoft Outlook

Windows Live
Mail

Adobe Acrobat
Internet Explorer
Hangul Word

Processor (HWP)
viewer

Autodesk
TrueView viewer

Metadata tab

Document Type

- Word documents
- Excel
spreadsheets

- PowerPoint
presentations

- Open Office
documents

- Rich Text Format
(RTF)

- plain text

- Microsoft Works
word processor
documents

Visio documents

Project 95 files are
text stripped
Project 98 files and
later versions are
supported

Outlook emails

EML files

PDF files
HTML Documents

Hangul word
processor
documents and
presentation files

DWG files are
supported for:

- 2004 version 16.0
release 18

- 2005 version 16.1
- 2010 version 18.0
- 2013 version 19.0

File Types

Word: *.doc; *.dot; *.wps; *.wpt; *.docx; *.docm; *.dotm; *.

dotx

Excel: *.xlIsb; *.xIsx; *.xlsm; *.xltx; *.xlk; *.vmIPowerPoint: *.
pptx; *.pptm; *.ppsx; *.ppsm; *.potx; *.potmOpen office and

Libreoffice: sxw; *.stw; *.doc; *.xml, *.rtf’ *.sdw

* vsd; *.vst; *.vss; *.vsdx; *.vSSX; *.vstx; *.vdX; *.vSX; *.vtx

*.mpp; *.mpt

* pst; *.ost; *.msg

* eml; *.mht; *.zmc

* pdf
* . html

*.hwp; *.hwt

* dwg; *.dxf; *.dwf

This tab displays the metadata associated with the previewed item, including properties and Nuix-defined

metadata.
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Image tab

When you preview an item that is an image, an Image tab automatically opens, and the following
information lists under Details:

® Width: Side-by-side measurement of the image, in pixels.
®* Height: End-to-end measurement of the image, in pixels.
® Colour Depth: Number of bits used for each color component, in pixels.

Click To...

Turn ON or OFF a solid background for images with transparent sections.
Rotate the image counterclockwise.

a Rotate the image clockwise.

Adjust the zoom for the image. The default is set to 100% but you can adjust it to
any of the following (%): 10, 25, 50, 75, 100, 125, 150, 200, 400, and 800.

-, Zoom:

Items Selected for Export View pane

This pane allows you to append items that you export together as a set.
To add an item or directory to the items selected for export:
1. Right-click an item or directory from either the Evidence Tree or Children pane.

2. Select Append To Export Items to add the selected items to the Items Selected for Export View
pane.

Muix Imager

File Edit Item Export Help

o Add Evidence... = Remove Evidence E Image Mobile Device B Save As . Export Disk Image @ Export Logical Image

Evidence Tree o B X Children
M B | —
view: |Resultslist | Tz | Loaded 2 chid items
@& 244.zip
- 92.5 Ac. Germany-Agency Relationship.pdfl [ Quick metadata only
[#-{ & Alstom Power.pdf I
BrLalEMC Emailite
E u—j: EPNG =l Remove Evidence
[ @‘g‘] EmailXtender 5 Select All Ctrl+A
&1-{& Enron Energy Select None Cirl+Shift+A
[/ & GE Systems.
A @ IMG_0017.MO |¢’ Append To Export [tems J
-] & Longview Owr . Cop Ctrl+C
[ -- Lyle.mov &
[E: -- Lyle2.mov B Save As
(1= MARATHON OF @ Launch ltem
E-g/| Mr Tachi.mov .
(1@ NAS Install, Tr @‘ Exportftems
e % ECTION 0_es| [ @ Export Item List
G- c?$d035bb5e [Eal Export Logical Image
- %) 4] edrm-enron " v
5 8 privizp B Export Disk Image
ol ] 07 Identify ltems
E : E Compute Digests
[E3E —T@E B LiA&.doox
BIHIS) #6242 UBIC. doox
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Once evidence is added, you can perform additional actions such as remove items, change the order
of items in the list, or export the items using any of the following options:

®* Export Logical Image: To export the items in the pane to a Nuix Logical Image file. See the Take a
Nuix logical image section for additional details.

® Export Iltems: To export items to a specified directory, and opt to include one of the following:
- Item details report: A CSV file of metadata for all items in the export.
- Compute MD5 digests: An MD5 digest (hash) for every item exported.
- Compute SHA-1 digests: An SHA-1 digest (hash) for every item exported.

® Export Item List: To generate an item details report and optionally include the MD5 and SHA-1
digests for each item in the view without exporting the actual items.

Status bar

The status bar displays the license being used and the number of processes running in the background.
View the status of background processes by clicking Processes Running. It displays:

® The currently running background processes.
®* The elapsed time for each background process.
® Options to:
- Stop or cancel currently running background processes.
A dialog box prompts you to confirm that you want to stop a process.
- Clear completed background processes.

0 processes running Clear ()
3 files processed 3/3
00:01:05 Completed @ e
3 files processed 3/3
00:00:32 Completed 9 Q
3 files processed 3/3
00:00:00 Completed 9 e
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Menus and their options

Nuix Imager contains the following menus which are separately detailed in the following pages:
File menu: This contains commands for working with evidence and configuring Nuix Imager.
Item menu: This contains several ways to display the evidence imported into the application.
Export menu: This contains several ways to export the evidence imported into the application, and
allows you to curate items together and export items as a set or individually.

These options are also available as icons in the space above the Evidence View.
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File menu options

The File menu in Nuix Imager contains commands for working with evidence and configuring Nuix Imager.

Command

Adding Evidence

Remove Evidence

Remove All
Evidence

Image Mobile
Device
Save As

Export Disk Image

Export Logical
Image

Global Options

Reset Layout

Sign out and Exit

Exit

Function

Adds evidence files to a case on selection of one of the following options:

Add Files

Add Split-DD Image

Add This Computer

Add Local Disks

Add Centera Cluster

This option is only available for the Email Archive Examiner and Ultimate
Workstation licenses. See License Profiles for the list of licenses Nuix offers.

See the Add Evidence in Nuix Imager section for more information.

Removes the item selected in the Evidence Tree pane from Nuix Imager.
Removes all the items in the Evidence Tree pane from Nuix Imager.

Takes an image of a mobile device. Instructions for both Android and iOS devices
can be found on Imaging Mobile Devices.

Saves the files in Nuix Imager. Then you can rename the file according to your file-
naming conventions.

Export evidence from Nuix Imager to a more convenient location. See the Export
menu options section for more details.

Exports a Logical Image. See the Export menu options section for more details;
and the Take a Nuix logical image section for more information on the images
themselves.

Sets configuration options for Nuix Imager. See the Configure Global Options
section for more details.

Restores the layout of Nuix Imager to its original configuration, losing all previous
changes.

Allows a user to sign out of their user account in Nuix Imager.
Note: Only available only for Cloud License Server users. It is not an option
supported on macOS.

If you sign in or out of Nuix Workstation, you are also signed in or out of Nuix
Imager. If you exit Nuix Workstation without signing out, Nuix Imager does not
require you to enter your login credentials when returning.

Exits Nuix Imager.

All these options are also available as icons in the space above the Evidence View.

File menu options
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ltem menu options

The Item menu in Nuix Imager contains several ways to show the evidence imported into the application.

Command Function

Identify Items Identifies unknown items after ingestion.
Compute Digests  Computes, on selection of one of the following options, the relevant file digest:

® Generate Iltem details report:

To produce a CSV file that includes metadata for all items included in the export.
® Compute MD5 digests:

To produce an MD5 digest (hash) for every item exported.
® Compute SHA-1 digests:

To produce a SHA-1 digest (hash) for every item exported.

Verify Image Verifies your image data after exporting the disk image.

Launch Item Opens the selected item in the supported application.

A warning appears to notify you that if the file is malicious, and opening it could
compromise your system.

If the machine running Nuix Imager has a means of mitigating this, or the file is not
malicious, click Yes or Always Yes.

Show in Parent Shows the selected item in the binary structure of its parent item.
Binary

Show in NTFS Shows the selected item in the NTFS Master File Table.

SMFT

Show in FAT Shows the selected item in its File Allocation Table (FAT) directory.
Directory

Show in File Shows the selected item in the file system.

System
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Export menu options

Through its Export menu, Nuix Imager provides several ways to export the evidence imported into the
application, and allows you to curate items together and export items as a set or individually.

Alternatively, you can select the required item and right-click it to view its context menu and select the
required command.

Command Function

Append to Export  The appended items appear in the Items Selected for Export pane.
Items

Export Disk Image To export the disk image of the evidence to an output directory, see Export disk
image under Export evidence for details.

Export Logical To export a logical image of evidence, see Export logical image under Export
Image evidence for details.
Export Items Export the items to the selected directory. Select the following options, if required:

® Generate Item details report
® Compute MD5 digests
® Compute SHA-1 digest

Export Item List Export the list of items to the selected directory, using one of the following options, if
required:

® Generate Item details report

® Compute MD5 digests
® Compute SHA-1 digest
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Configure Global Options

Configure the settings in Nuix Imager through Global Options.

To set the global options, click File and select Global Options.

Evidence Options tab

Evidence options enable you to configure the settings required for working with the evidence.
In the Evidence Options window, configure the following:

® Evidence Options
®* Memory

* Metadata Profiles
® Launching

B tvidence Options — X

=0 D ¢

Evidence Options Memory Metadata Profiles Launching

Character encoding:
(O Prompt for a character encoding when adding new evidence.
(®) Use the system default character encoding when adding new evidence.
() Use the specified character encoding when adding new evidence:
windows-1252
Zip character encoding:
Use evidence charset v
Time zone:
(O) Prompt for a time zone when adding new evidence.
(®) Use the system default time zone when adding new evidence,
(0) Use the specified time zone when adding new evidence:
(GMT +10:00) Australian Eastern Standard Time (Australia/Sydney)

[[] Extract mailbox slack space

Password discovery mode: None 1EY

Word list:

Character encoding

Select the required option to set for character encoding:

Prompt for a character encoding when adding new evidence.

Use the system default character encoding when adding new evidence. This is the default setting.
Use the specified character encoding when adding new evidence. Select an encoding format from
the list. Windows 1252, UTF-8, and Adobe Standard Encoding are the most frequently used and
appear at the top of the list as a result.
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Zip character encoding

Select the Zip file encoding charset from the list.

Time zone

Select the required option to set for time zones:

* Prompt for a time zone when adding new evidence.
® Use the system default time zone when adding new evidence.
(Default setting).
® Use the specified time zone when adding new evidence.
The system default time zone appears by default when selected. To update, select the appropriate
one from the list.
® Extract mailbox slack space.
Select this option to remove the empty (slack) space in your mailbox during importing.

Password discovery mode

A password bank is a password repository used to decrypt password-protected files during discovery
and processing. Password banks are used to decrypt files, enabling you to manage password lists by
adding them manually or importing a word list using a .txt file. When using a password bank, Nuix Imager
runs passwords against each encrypted file until it finds a match.

Select Word list to add a word list. By default, the Password discovery mode is set to None.

Word list

If you selected Word list as the Password discovery mode, add the required word list using a .txt file.
The word lists created then appear in the drop-down list indicating the number of words in the list.

Click Manage password lists to update the word lists using the following options.

Icon Description
Add an entry
|:| Edit the selected entry.

To import a list from your computer, click Import Words.
To export your created list, click Export Words.

Note: To import or export words, use Plain Text files (*.txt).

Remove the selected entry.

Move the entry up in the lists.

Move the entry down in the lists.

[d B [0
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Memory tab

The Memory option allows you to configure the amount of RAM made available to Nuix Imager. Increase
or decrease this value depending on the size of the case being ingested. Ensure to reserve some
memory for load and export workers when adjusting this setting.

The default setting for Application memory is 1,300 (1.3 MB). Adjust to any value, in 128 MB increments,
by using the up and down arrows, from 788 MB up to 17,044 MB.

Note: Restart Nuix Imager for the changes to take effect.

Metadata Profiles tab

Metadata is the data that provides information about other data, facilitating a clear analysis of
data. Metadata Profiles enable you to configure profiles for metadata fields. You can create profiles
specifically for a Case, User, or Local Computer. You can also export or import a previously defined profile

from a file.

Evidence Options

e O D D

Evidence Options Memory Metadata Profiles | Launching
Configure profies for metadata which can be used in different contexts in the application.

[context =
Default

Discover

Mew metadata profile

+ & - ] Mowve... Duplicate Import... Export...

To create a metadata profile:

1. In the Metadata Profiles window, click the plus icon (+) to add a profile.
2. To define the scope of the profile, select one of the following:

- Case

- User

- Local Computer

In the Create Metadata Profile dialog box, click the plus icon (+) to select the metadata type.
2. Use the Filter option to select the required metadata, and click OK.

The selected metadata is added to the profile.
3. Then perform the following actions on the selected metadata:

=
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Action

[=]
[-]

]

Description

To modify/update the selected metadata.
To delete the selected metadata.

To move the selected metadata up in the list.

To move the selected metadata down the list.

4. Click OK to save the profile. Rename the profile as required.

More actions to apply to metadata

Action

Move
Duplicate
Import

Export

Description

To modify or update the selected metadata profile.

To permanently delete the selected metadata profile.

To rename the selected profile.

To move the selected profile to another scope.
To create a copy of the selected profile.
To import a Nuix metadata profile file.

To export the Nuix metadata profile file.

For details on metadata, see the Building Metadata Profiles section in the Nuix Workstation User Guide.

Launching tab

The Launching tab allows you to set the default application you want to use when opening items on the

Native tab in the Iltem
To set the default appl

1. Click the Launc

Configure Global Options

pane.

ication to use when opening items on the Native tab:

hing tab.
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Evidence Options

s 8 D D

Evidence Options Memary Metadata Profiles Launching

Choose the default format to use when launching messages:

EML (REC822MIME in individual files) : -

2. Select one of the following formats:
- EML: Standard message format (RFC822) and default option.
Windows systems and other email programs mostly default to using Outlook Express.

The prompt to configure this may still display even if you close the configuration window.
- MSG: Microsoft Outlook individual files

- NSF: IBM (Lotus) Notes mailbox

Configure Global Options
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Add evidence

Locations of evidence

Nuix Imager simplifies the process of adding evidence extracted from the following locations:

®* Alocal computer

® A connected network, including from:
® Amazon S3 buckets

Documentum servers

Exchange servers

Mail stores

Microsoft Office 365

Microsoft SQL servers

Oracle databases

Secure Shell (SSH) servers

SharePoint servers
® Twitter accounts

® A Cloud account, including from:
® Apple iCloud accounts

Box accounts

Dropbox accounts

Google accounts

OneDrive accounts

Ways to add evidence

1. Click Add Evidence at the top left of the menu bar, and from a local computer, a network or a cloud
account, select the source of the evidence to import it.

+ nnuﬁwmn__ Remove Evidence [ ImageMobie Device [l Save s [} Export Disk Image [} Export Logical Image [} Cor
add Local
m— —
P o 8 B g
- .
+ + —t -
Fias Foldérs Split-DD Image This Compuber Local Disks
Add Nebwork Evidence
@) - -- s
=4 - -gﬂ:' _,SQI_,'- ,SQT,," =i
Ml Stewe Amaren 53 Buckats SharaPaink Server Micrasaft SOL Serves Oracle Databage Do b Serner
G
-
S SHI
55H Server Tweitber Account
Add Cloud Account Evidence
S OT o e @
v v’
Droghax Dropbax
Incivicual Acopunt Team Acopunt Box Account Enterprize Box Acc... Googhe Drive: Mirosoft OneDrive
Apple iCloud

You may then need to supply valid credentials and additional connection information. This depends
on the evidence location you select.
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Refer to the Images section in the Nuix Supported File Types document for details on file types that
Nuix Imager supports.

2. Drag and drop evidence from your computer into the Evidence Tree on the left-hand side of Nuix
Imager.
Do this after you find the local, network, or cloud account evidence.
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Access local evidence

Local evidence is an individual file or directory that is accessible from the computer currently running Nuix
Imager. This includes mapped network drives. The following options are available to import.

Option

Files

Folders

Split-DD Image

This Computer

Local Disks

Centera Cluster

Access local evidence

Description

Select files from a computer, network, or external drive (For example, PST, EDB,
NSF, MBOX, and so forth.)

Select a directory that includes all files to be processed.

Select the initial DD image file from a directory to add to the case.

Note: DD files can be segmented image format files. All file segments for the same
image must reside within the same directory. Adding the initial of the leading
segment file adds the remaining segments as well.

Choose this option to add any kind of split file.

To include all available files contained on the local computer, including logical and
physical drives attached to the computer.

To add a specific local disk from the local computer.

Connects to and extracts source data directly from a Centera Cluster.

Note: The Centera Cluster option is only available for the Email Archive Examiner
and Ultimate Workstation licenses.

In the dialog box that appears, use the drop-down menu next to each of the
following to select a valid file:

® |P address file
® Clip file

Once you have selected the files, click OK.
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Extract network evidence

Network evidence is the content hosted on a local server that is accessible through a network connection.
Nuix Imager allows you to connect to and directly extract the data from the following:

Amazon S3 buckets
Documentum servers
Exchange servers

Mail stores

Microsoft Office 365
Microsoft SQL servers
Oracle databases

Secure Shell (SSH) servers
SharePoint servers

Twitter accounts

This section details how to connect to these servers, stores, databases and accounts in the alphabetic
order they are listed in.

Extract from Amazon S3 buckets

To connect to and extract source data directly from Amazon S3 buckets using web services, complete
these fields:

Field Description

Saved Credentials Allows you to select a saved credential from the list. They are stored for the
evidence type in Global Options or Preferences.

Allow credential discovery automatically discovers credentials when they are not supplied.

Access Key Enter your Amazon-provided Access Key and Secret Key for the S3 account.
Secret Key
Endpoint Optionally, enter the URL of the S3 server to connect to a specific region, for

example, https://s3.amazonaws.com.

Bucket (along Enter a bucket name. If none is specified, then all buckets in the account will be
with Path) ingested.

You can limit the ingestion to a specifically named bucket or to a folder in the
bucket by specifying a bucket name followed by a path. If this is omitted, all
buckets in the account are ingested, for example, "com.company.testbucket/nested
[folder".

If a bucket that allows anonymous access is supplied, then credentials are not needed. Otherwise, you
must provide one of the following:

® Access Key and Secret Key provided by Amazon for the S3 account

® Credential store, by selecting a previously stored set of credentials

® Credential discovery, to automatically discover credentials from the AWS library and include a
system property
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The ingestion can be limited to a specifically named bucket or to a folder in the bucket by specifying a
bucket name followed by a path, for example, "com.company.testbucket/nested/folder". If you do not
specify a bucket, then all buckets in the account are ingested.

You can usually leave the endpoint unspecified. However, you can use it to force the service to connect to
a particular S3 server, useful when connecting to a specific region.

Extract from a Documentum server

To connect to and extract source data from OpenText Documentum Server:

1.
2.

3.
4.

Select the Documentum Server, so the Documentum Location window appears.

Provide the following:

Server address

Port

User credentials

Domain, query (by default, the query is “select * from dm_document”)

Your docbase

Your property file (this must be a valid file)

Click Retrieve Docbases to ensure you are connected to the server and retrieve the dochases.
Click OK to process data.

~P2o00p

Extract from an Exchange server

This procedure can also be used to connect to an Office 365 instance of Exchange.

To connect to and extract source data directly from an exchange server (2007-2016) using Exchange Web
Services (EWS):

1.

2.

10.

In the Exchange Location dialog box, in Saved Credentials, provide the appropriate credentials to
collect information from this source.

Specify the Exchange server.

A valid Exchange server takes the following form: "https://ex2010.company.com/ews/exchange.asmx
". This example can also be specified as "ex2010.company.com” or with an IP address and the
protocol, allowing the path to the web service to be added automatically.

Specify the Domain, Username and Password.

. Select the Impersonation checkbox if you want to act as though you are the client for the purposes

of retrieving the evidence.

Specify the Mailbox, .

In Mailbox retrievals, select the individual name of the user’'s Mailbox and Archive, and select the
check boxes for the folders you want to process.

. Select the Start date and End date for the data being added, using the dropdown calendars.
. Click Save to save these credentials in the credential store.

These credentials can be loaded and/or saved when adding EWS mailboxes to evidence. To learn
more about managing the connection and authentication information, see the Credentials section in
the Configuring Global Options section.

. Click Add More to add multiple mailboxes found at the same location by entering the user’s settings

and pressing Ctrl + Enter to add mailboxes. Repeat until you have entered the credentials for all
mailboxes in a specified location.

Once you have configured all the options, click Test Connection to ensure you are connected to
the server, and click OK.
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Exchange Location

Saved Credentials: W

Exchange server: |office365. microsoft. com

Dormain:
|Username; admin@nuix. onmicrosoft, com
Password: TIIIIL

Impersonating: D

Mailboe: robin@nuix. com

Mailbox retrievals: | Mailbox/Current;Mailbox/Recoverable Ttems; Archive/Curre... w
Start date: W

End date: W

Save Add Mare Test Connection

oK Cancel

Use a Mail Store

To connect and extract data through a mail store:

1. Select an individual mail store via POP or IMAP.
Use this method to connect to Novell GroupWise or for corporate mail servers that support POP and
IMAP connections, and for loading Gmail, Hotmail, and other Internet-stored email data.
2. In the Add Mail Store dialog box, specify the following
a. In Mail store profile select one the following: Gmail, Outlook, Yahoo!, Apple, AOL, Zoho,
Mail.com, Yandex, GMX, and inbox.com
b. In Mail store type select one the following: POP, POP+SSL, IMAP, IMAP+SSL,
and GroupWise.
c. Enter the server hostname and server port.
d. Enter your user name and password.
e. Click OK.

Note: Connecting to corporate mail servers can result in exporting large volumes of data, and therefore
putting a heavy strain on the server. As best practice, store a binary copy of the items harvested from a
Mail Store as pointers to items can often change within mail servers.

Once you have configured all the options, click Test Connection to ensure you are connected to the
server, and then click OK.
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Extract from Microsoft Office 365

Use this connector to retrieve data from Microsoft sources including Teams, Exchange, and SharePoint.
This procedure involves that you do the following in this order:

. Connect and extract source data directly

. Configure connection details for the connector
. Specify users or team names

. Apply additional filters for ingested data

A WDNPEF

(D) Nuix Connector for Microsoft Office 365 Guide

To use this feature, your Azure tenant must be configured by an Azure Global Administrator to
enable authentication and specify the appropriate API data permissions. Refer to the Nuix
Connector for Microsoft Office 365 Guide for more information about the connector and the Azure
tenant configuration process. Download PDF documents from the Nuix Customer Portal.

To avoid reduced performance and potential data loss resulting from connection throttling, it is
recommended to not use more than four workers when ingesting data from Office 365. If ingesting
a single Exchange mailbox, the total number of workers should be further reduced to a maximum

of two to ensure the best performance.

Connect and extract source data directly
To connect to and extract source data directly from a Microsoft 365 instance hosted on Azure:

1. Open the Microsoft Office 365 Location dialog box, and on its three tabs:
a. Configure connection details for the connector.
b. Specify users or team names.
c. Apply additional filters for the data to be ingested.

Microsoft Office 365 Location =
Credentials Specify Users/Team Names  Additional Filters

Saved credentials: e

Microsoft Office 365 Credentials:

Directory (Tenant) ID:
Application (Client) ID:
Authentication Method

(®) Client Secret () Certificate

Client secret:

These procedures are fully detailed in the following sub-sections.
2. When you have defined options on all three tabs, review your selections and click OK.

Extract network evidence
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Configure connection details for the connector

To configure connection details for the connector:

1. On the Credentials tab, enter details generated for the Nuix authentication application when

registered in the Microsoft Azure portal.
Contact your Azure Global Administrator if you need this information, OR if you previously saved the
credentials for this connection, select them from the Saved credentials menu.

Property Required Description

Directory Yes The ID of the Azure Active Directory (AAD) tenant where the
(Tenant) ID authentication application was registered.

Application Yes The application ID of the registered authentication application
(Client) ID

2. Select one of the following authentication methods:

Method Required Description

Client Secret Yes Provide the authentication key string associated with the Application
(Client) ID.

Certificate Yes Provide a PKCS#12 based private key certificate and password.

Note: The certificate file must have a . PFX or . P12 file extension.

3. Select the services and associated data types to ingest using the connector, as follows:
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Service Data Type

Teams Team Calendars

Team Channels

User Calendars

User Chats

Exchange User Emails

User Contacts

Organizational
Contacts

SharePoint SharePoint Data

Description

Retrieve Teams calendar data from all teams that a
specific user is a member of.

Note: If selected, you must provide credentials for a
Microsoft Teams user to retrieve calendar data.

Channel data such as chat messages and attachments
from all public channels within a team.

Note: User emoji reactions to chat messages are
included as child items of the parent message.

Individual user calendar data from the members of a
team.

Chat messages from one-on-one or group
conversations that take place outside of a public
channel.

Note: See the section on Private Chat Limitations for
additional information at the end of the 'Use Microsoft
Office 365’ topic.

Individual user mailboxes.

Tip: Select Extract from mailbox slack space when
configuring your data processing settings to also
retrieve lower-level folders from the mailbox.

Personal contacts that have been saved by individual
users.

Contacts created by an administrator are shared with all
users in an organization. Also known as Mail Contacts
within Exchange.

Collect data from SharePoint sites, subsites, lists, and
users.

Note: The retrieval of SharePoint list attachments is not
supported.

For all services, traditional and modern OneDrive for Business attachments are included as child

items of the parent item.

Tip: Click Save Credentials to store the provided credentials to a profile for later reuse. If
Certificate-based authentication is selected, only the path to the certificate on the local file system
and associated password is saved. The certificate file is not stored within the profile.

4. Click Test Connection to verify the connection details.
5. Once verified, proceed to the next section to define filters on the remaining tabs of the connector or

click OK.

Also see Private Chat Limitations and Workaround at the end of this Use Microsoft Office 365 topic.

Extract network evidence
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Specify users or team names

To narrow the data retrieved from the Microsoft Office 365 connection by filtering on specific users and or
Team names:

1. On the Specify Users/Team Names tab, select one of the following filters listed at the top of the tab:
- User Principal Names: To retrieve data from specified users only.
(A User Principal Name (UPN) is the name of a Windows Active Directory system user in
the format of an email address. For example, john.doe@domain.com.)
- Team Names: Retrieve data from specified teams only.
- None (default): No Filter. Retrieve all data.

Microsoft Office 363 Location =

Credentials | Spedfy Users/Team Mames | additional Filters

Choose how to scope data:
(®) User Principal Mames () Team Names ({_) None

Add User Principal Mame(s):
Validate

Users to filter on:

Cancel

2. In User Principal Name(s), based on the selected filter, enter a semicolon-separated list of either
UPNSs or Team names.
(SharePoint data is unable to be filtered by UPN.)

3. Click Validate to verify the entries and add them to the filter.
If any names are invalid, the connector will specify which values could not be found.

Tip: Prior to starting ingestion, you can view a list of available user and team names by selecting
None as the filter option and then OK to exit the connector configuration. Proceed to the Pre-Filter
Evidence view to see results. You can also use Nuix Imager to preview the data set.

4. Once validated, click OK to return to the Add/Edit Evidence page or proceed to the next tab to
define additional filters on the remaining tab of the connector.

Apply additional filters for ingested data

To apply additional filters to the data being ingested:

1. On the Additional Filters tab, in Select Email Folders, select one of the following to specify the
types of Exchange mailbox folders to retrieve:

Note: If you did not select the Exchange service on the Credentials tab, this filter will not affect
data.

®* Account: All mailbox folders available within the account
®* Mailbox: Current mailbox data and recoverables such as deletions and purges.
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® Archive: Archived mailbox data and archived recoverables such as deletions and purges.
® Public Folders: Shared folders within an organization.

Microsoft Office 365 Location ad

Credentials  Specify Users/Team Mames  Additional Filters
Select Email Folders

Mailbox/Current;Mailbox/Recoverables /Ttems; Archive /Current; Archive fRecov.., -

Filter by Date
?
From: | 111119, 7:00 PM e
To: | 11/12/20, 6:59 PM v

Version Configuration

Current and past versions of Microsoft 365 files can be ingested. Ingesting all
versions will take longer to process. Limiting the scope to a fixed number of past
revisions is advised.

. . -
Limit past number of versions: 20 -

Cancel

Exchange Limitations: In-Place archives included within user mailboxes and Inactive
mailboxes cannot currently be collected using the Microsoft Graph API.

Data from inactive mailboxes, however, can be extracted using the Microsoft Security &
Compliance Center and then ingested. See the Microsoft topic: Search and export the
contents of an inactive mailbox for more information.
2. Under Filter by Date, use the calendar selectors to define how to retrieve only the items that have a
Last Modified date within the specified date range.

Note:

If there is no Last Modified date, the item's Creation Date is used. The filter defaults to one year,
starting 365 days prior to the current date. If retrieving calendar data, the date range cannot exceed
five years (1825 days).

This filter only applies to the following Office 365 item types:
- Exchange mail messages

- Teams chat messages

- Calendar events (filtered by scheduled event start time)

- Resources from SharePoint and OneDrive for Business

3. Under Version Configuration, choose either of the following options:
® Latest Version to ingest the latest version of a file or attachment (selected by default)
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® All versions within defined date range to ingest all available versions within a specified
date range, and verify that the displayed date range is correct.
Only files with a Last Modified date within the range will be ingested.
To modify the date range, update the From and To values in the Filter by Date section.
4. Optionally, select the Limit past number of versions checkbox to restrict the number of retrieved
versions to a specified number.

This filter applies to all files and attachments retrieved from Microsoft 365 in which versions are
maintained, including data from SharePoint, OneDrive for Business, and Teams.

After ingestion is complete, the following version-related metadata is included on all applicable items and
can be viewed and queried in the case:

Metadata Value

Fl ag: versioned boolean
Fl ag: boolean
current version

Property: integer
Ver si on Age

Property: string
Versi on G oup

I D

Property: integer

Ver si on Val ue

Description

Indicates that multiple versions of the selected item exist and have
been ingested.

Indicates if an item is the most recent version. Determined at the time
of ingestion.

Identifies the version of the selected item in relation to the latest known
version.

A value of 0 represents the latest version. Each increment of 1
indicates a subsequent older version.

Warning: If you update the data in a case by reloading the source data
or scanning for new child items, the Version Age of an item changes if
newer versions of that item are found.

A unique identifier that is used to link all versioned items from a single
original document.
The Version Group ID value is derived from the original item's | D value.

Identifies the exact version of the selected item based on source data.
Note: Microsoft 365 uses a basic sequential numbering method (1.0,
2.0, 3.0) when assigning version values. Other data sources may
assign non-readable values, such as a hash, when defining this value.

The following table contains example queries that can be used after ingestion to locate versioned items

within a case:

Example Query Description of Results

fl ag: versi oned Returns all items that have multiple versions.

flag: (versioned AND  Returns the latest version of each item that has multiple versions.

current _version)

flag: (versioned AND  Returns all versions of an item except for the latest version.

NOT current _version)

i nteger-properties:" Returns the most recent version (indicated by 0) and the previous 10
Version Age": (0 to versions.
10)
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properties:"Version Returns all items that have a version value that matches the value
Val ue: 2. 0" specified in the query (2.0).

properties:"Version Returns all versions of an item, including the original, that match the group
Goup I D ID specified in the query.
<GROUPI DGUI D>"

When finished, review your selections on the previous tabs or click OK.

Private Chat Limitations

Due to restrictions in how private chat data is retrieved using the Microsoft Graph API, certain limitations
exist when determining the recipients of specific messages within a chat. Limitations include:

® Chat/conversation IDs are only generated when a new chat is initiated. The generated ID is
persisted for the entire life of the chat, regardless of whether participants are later added or removed.
® The To communication metadata property, which identifies the participants of a chat, represents
only the list of participants that are included in the chat at the time of ingestion. Due to this limitation,
the following must be considered:
* New participants who are added to an existing conversation are identified in the metadata as
a chat recipient. However, based on the chat history settings selected when adding the new
participant, they may or may not have been granted access to view messages that were sent
prior to them joining the chat.
® Participants who left a chat after receiving messages will not be identified in the metadata as
a recipient at all.

Workaround: To establish a complete view of recipients and verify who received messages from a private
chat conversation, examine the specified private conversation from the /Users/<userName>/Chats
directory of each suspected participant.

For example:

To verify if John saw a specific private chat message, examine the messages located in /Users/John
/Chats. Looking at the same chat but from a different participant, /Users/Jane/Chats, may not properly
confirm if John saw a specific message because Jane's chat history may be incomplete and reflect only a
portion of the conversation due to the limitations previously noted.

Extract from a Microsoft SQL Server

To connect to and extract source data directly from a live Microsoft SQL Server engine instance:

1. Ensure the following:

a. Your Database Administration procedures are current, including backup and recovery.
The engine instance must be configured to allow TCP/IP connections.

b. You remove any firewall restrictions between the Nuix Workstation application and the
database instance to allow the connection.

c. The engine instance is live but idle.
Any concurrent activities performed when the content is being read or being reviewed and
analyzed can produce inconsistent Nuix Workstation results.

d. The credentials used to connect to the Database have the necessary permissions to read the
content.
Nuix recommends you use the System Administrator (‘sa’) account, or another account with a
fixed server role ‘sysadmin’. Ask your Database Administration support for more information.
Find further information on the Microsoft SQL Server product at https://www.microsoft.com/en-
us/sql-server.
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2. Inthe MS SQL Server Instance dialog box, specify the server name and username and password.
3. Optionally specify the following parameters, as necessary:
a. Instance name (depends on the engine configuration)
b. Domain (requires credentials to access the server)
c. Query (the consistent SQL query to filter the content)
A query parameter is an advanced option that allows you to specify the SQL query to obtain
the data, including the use of SQL JOIN to combine different databases and tables. It is
intended for users with proficient SQL knowledge.
4. To select all data from a known list of databases and/or tables, use the Pre-Filter Evidence dialog
box to specify the required data.
5. Click Test Connection to ensure you are connected to the server.
6. Click OK to process data.
7. Check your database client utility if you encounter a problem while connecting.

Use an Oracle database

To connect to and extract source data directly from a live Oracle database instance:

1. Heed all warnings stated in the previous Use Microsoft SQL Server section.
2. Inthe Oracle Instance dialog box, enter the following parameters:
a. In Database, also known as the <database> description, is one of the following:
/] <host >: <port >/ <servi ce>

<host >: <port >: <S| D>
<TNSName>

This Database value connects to a database with service litmus through port 1521 of
host myserver:

[/ myserver: 1521/ 1itnus

This Database value connects to the same database using the SID inst1:

nyserver: 1521:instl

b. Enter the user name and password.

c. In Role, specify the role to connect as. For example, when connecting with the “SYS” user
account, the role should be “SYSDBA” or “SYSOPER”.

d. In Query, specify if you want to supply an SQL SELECT query to filter the content, including

the use of SQL JOIN to combine different databases and tables.

In Max Rows, specify how to limit the number of rows returned from each table.

Click Test Connection to ensure you are connected to the server.

Click OK to process data.

Check your database client utility if you encounter a problem while connecting.

TQ - @

Extract from a Secure Shell (SSH) server

To connect to and extract source data directly from a Secure Shell (SSH) Server:
1. Select the Secure Shell (SSH) Server option to view the following settings enabled and set or

selected by default:
a. Port: Setto 22 - which you can adjust up or down using the arrows to the right of the box.
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b. Access Remote Files: If you use this, you can set an Initial remote folder to speed up initial
remote access.
This is helpful if you want to narrow the scope of the data by using a certain directory.
c. SSH Key Pair Authentication
2. Enter your Host Information, User Name and, if you selected Password Authentication, a password
for the remote access you want to set up.
3. Optionally, also select Access Remote Disks.
4. If necessary, also select a Key Folder from which to select files.
5. If you use a “sudo” password, which allows access to write-protected files and folders, enter it in this
box.
Using a user name and password instead of a key pair automatically attempts sudo access on read-
protected files.
. Click Test Connection to ensure you are connected to the server.
. Click OK to process data.

~N O

Extract from a SharePoint server

Nuix Workstation supports SharePoint extraction from servers hosted in 0365 Online or On-premise
servers.

To access the required SharePoint server, you must have an administrator account to select from the
following:

® (0365 Online: Microsoft provides online SharePoint servers hosted in O365 or the Azure
environment.
If you deploy your server in Azure or directly and use the servers that Microsoft provides, then you
need the clientld/clientSecret of a 'SharePoint Add-In App', and do not need a SharePoint account
credential.

®* On-premise: If you deploy the server on premises, ensure you have the user credentials for the
administrator account or any account you want to investigate.

To add a SharePoint Server:

. Create a server URL hosted in 0365 Online or Azure environment.

2. Create a domain name, for example, if the server URL is https://website.com then 'website.com'
(URL without protocol) is the domain name.

3. Assign permissions to the client ID generated in the previous step,

[N

<AppPer m ssi onRequests Al | owAppOnl yPol i cy="true" >
<AppPer m ssi onRequest Scope="http://sharepoi nt/content/sitecollection" R ght="Read" />

</ AppPer m ssi onRequest s>

OR

<AppPer m ssi onRequests Al | owAppOnl yPol i cy="true">
<AppPer m ssi onRequest Scope="http://sharepoi nt/content/sitecollection" Ri ght="Read" />
<AppPer m ssi onRequest Scope="http://sharepoi nt/content/sitecol | ection/web" Ri ght="Read" />
<AppPer m ssi onRequest Scope="http://sharepoi nt/content/sitecol |l ection/web/list" R ght="Read" />

</ AppPer m ssi onRequest s>

OR, if you have tenancy permissions:

<AppPer m ssi onRequests Al | owAppOnl yPol i cy="true">
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<AppPer m ssi onRequest Scope="http://sharepoi nt/content/tenant"

</ AppPer mi ssi onRequest s>

4. Click Trust It to continue.
5. Enter the SharePoint location details:

Field

SharePoint server

Domain

Username

Password

6. Select Test Connection to test the connection and credentials.

7. Click OK.

0365 Online/ Azure

Enter the server URL hosted in O365
online or Azure environment or the exact
URL of the site that is being collected.

Enter the domain name. For example, if
the server URL is https://website.com

, then enter 'website.com' (URL without
protocol) as the domain name.

Enter the clientld of a SharePoint Add-In
app.

The client secret of the SharePoint Add-
In app.

Configure SharePoint Servers to use REST APIs

Ri ght =" Read" />

On-premise

Enter the endpoint URL to the
SharePoint server for On-
premise.

Enter the domain name of this
user. Nuix recommends to
leave it empty if you just want to
use the REST services.

Enter the username of the
account you want to investigate
or the username of an
administrator account of this
server.

Enter the appropriate password
associated with your username.

The SharePoint servers do not provide access to REST APIs by default. You must configure them on the
servers to be able to invoke them.

Configure On-premise SharePoint servers

Ensure you have Nuix Workstation and a SharePoint server on the same network.

To configure for On-premise servers, use basic authentication in Internet Information Services (IIS).

To update the settings in IIS:

1. Log in to the virtual machine on which the SharePoint server is hosted.
2. Goto IS, select Sites, select Intranet, right-click Basic Authentication, and then click Enable.

To update the settings in the SharePoint server:

PobpE

a. Full Control: for full control
b. Read: for permission to view pages and list items and download documents

Extract network evidence

Select the Settings option in the top right corner of the main page and click Site settings.
Select Users and Permissions and click Show users to see all the user details.

Select the Everyone check box and click Edit User Permissions.

Select one of the following permissions and click OK.
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Configure O365 servers

To configure an 0365 server:

1. Create a SharePoint Add-In, and to register the Add-in in SharePoint:
a. Navigate and log in to the SharePoint online site.
b. Navigate to the Register Add-in page by entering the URL in the browser as
https://<sitename>.SharePoint.com/_layouts/15/appregnew.aspx
c. Generate your Client Id and Client Secret and click Create. Ensure the Redirect URI requests
an 'HTTPS".
All information regarding the Add-In appears. Record the details for future reference.
2. On registering the Add-In, set permissions to access the SharePoint data. Set the Read permission
level to the web scope to be able to read the web information:
a. Navigate to the SharePoint site and enter the URL 'https://<sitename>.sharepoint.com
/_layouts/15/appinv.aspx’ in the browser. It redirects you to the Grant permission page.
b. Enter the Client ID in the App Id text box and click Lookup. It populates the value for the
following fields: Title, App Domain, and Redirect URL.
If Lookup does not populate the other field values, enter them manually.
c. Update the Permission Request XML as follows and click Create.

<AppPer m ssi onRequests Al | owAppOnl yPol i cy="true">
<AppPer m ssi onRequest Scope="http://sharepoi nt/content/sitecollection" Ri ght="Read" />
<AppPer m ssi onRequest Scope="http://sharepoint/content/sitecollection/web" Ri ght="Read"
/>
<AppPer m ssi onRequest Scope="http://sharepoi nt/content/sitecollection/web/list" R ght="
Read" />
</ AppPer m ssi onRequest s>

d. In the page that appears, click Trust It. This enables you to invoke the REST APIs on the
server.

Permissions required for SharePoint ingestion

To perform a SharePoint Collection you can use the built-in Contribute/Design/Full permissions or you can
create a custom permission level that includes browsing and opening features.

The recommended way to configure this, for a Nuix ingestion account that has true read-only permissions
to SharePoint, is to:

1. Create a new permission level, which is a copy of the Read permission level with the browse
directories permission enabled.
2. Create a new group with this new permission level.

3. Add the Nuix ingestion user to this group.
4. Provide this user's credentials to Nuix for ingestion.

Extract from a Twitter account

This option supports Twitter historical data by getting a list of the recent tweets with an approximate return
of up to the latest 3,200 tweets. On selecting this option, the Twitter Historical Data window appears.

Note: This feature requires users to have their own API key.

To connect to and extract source data directly from a Twitter account:
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1. Create a Twitter App and Access Token, as follows (which is only a recommendation):
a. Register your own Twitter developer account at https://developer.twitter.com/.
b. Create your own app at https://developer.twitter.com/en/docs/basics/authentication/guides
/access-tokens.
c. Obtain an access token at https://developer.twitter.com/en/docs/basics/getting-started, where
you can also perform steps 1 and 2 as well.
2. Enter your Twitter account details with the Consumer Key, Consumer Secret, Access Token,
Access Token Secret, and Screen Name.
3. Click Test Twitter Connection to check if your Internet connection to Twitter is working, your
credentials are authorized, and if the screen name you provided is valid.
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Import cloud account evidence

Cloud account evidence is content stored using a cloud storage service. Nuix Imager allows you to
connect to and directly import the data from the following cloud accounts:

- Apple iCloud, Google and Microsoft OneDrive accounts

- Box and Dropbox accounts

This section details how to connect to these accounts in the alphabetic order they are listed in.

Import from an Apple iCloud, Google Drive, or OneDrive account

Add AppleiCloud account

To connect to and extract source data from your Apple iCloud account, including iCloud drive files, iOS
backup, and ubiquity data:

Note: Two-Factor Authentication is supported for iCloud data, but not for iOS backups.

1. On receipt of your two-factor authentication code on your device, provide your account and
password information.
2. Click Test Connection to ensure you are connected to the server, then click OK.

Add a Google Drive account

To connect to and extract source data from your Google Drive account:

1. Select the Add Google Drive Account option to open the Google sign-in window.
2. Enter your Google sign-in details.
3. Click Allow once you are ready to authenticate.

Add Microsoft OneDrive account

To connect to and extract source data from your Microsoft OneDrive:

1. Select the Add Microsoft OneDrive Account option to open the Microsoft sign-in window.
2. Enter your Microsoft sign-in details.
3. Click Allow once you are ready to authenticate.

Import from Box and Dropbox accounts
Connect to and extract source data from either a Team or Individual Dropbox account.

Add a Box account

1. Select the Box Account option. The Box login page appears.
2. Enter your login details, and click Authorize.
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Add an Enterprise Box account

To connect to and extract source data from your Enterprise Box account:

1.
2.

o

Sign up for a developer account at https://app.box.com/developers/console.

Create an Enterprise App using the OAuth 2.0 with JWT authentication option for Server
authentication.

This allows you to retrieve folders from your Box account with a Developer token.

In the Advanced Features section, enable Perform Actions as Users and Generate User Access
Tokens, and click Save.

. Next, generate a Certificate to allow your browser to download the config.json file.

Note: Store the config.json file you create securely, as you cannot download it again.

. Sign in to your Box account, and from the Admin Console, go to Enterprise Settings and then to

the Apps tab to authorize your new app.
When prompted to supply an API key, do so in the value next to ‘clientID’ in the config.json file.
When the following screen appears, confirm all details match your setup and click Authorize.

App Authorization

The selected application (Muix Dev Team Enterprise) would like
permission to manage the following within your enterprise:

Read and write all files and folders stored in Box
Manage groups

Manage enterprise properties

Manage users

Manage app users

Admin can make calls on behalf of Users
Generate Tokens

# % ® ® ¥ ¥ ®

For the following users:

= All Users

Authorize

Add Dropbox team account

To add a Dropbox team account:

1.
2.
3.

Select the Add Team Account option. The Dropbox login page appears.

Enter the login credentials, and click Sign in. The team account authentication page appears.
Click Allow to proceed. In the Pre-Filter Evidence panel, a list of all the accounts in the team
appears.

Select the accounts to ingest and click OK.
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Add Dropbox individual account

To add a Dropbox individual account:
1. Providing the credentials to the account to ingest per the preceding Add Dropbox team account.

In the Pre-filter Evidence panel, only the individual account is listed to ingest.
2. Click OK to proceed.
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Export evidence

Through its Export menu, Nuix Imager provides several ways to export the evidence imported into the
application, and allows you to curate items together and export items as a set or individually.

This sections covers the following topics:
- Export a disk image
- Export a logical image
- Export items of evidence as a report or digest
- Export a list of evidence items as a report or digest

Export a disk image

To export the disk image of the evidence to an output directory:

1. In Nuix Imager, select the Export menu, and the Export Disk Image option.
2. Under General Settings, enter or select details as follows:
a. InImage Type: Select either RAW or EO1.
b. In Output Directory: Enter the directory where the output file is saved after export.
c. InImage Base Name: Enter the name given to the image export.
d. In Case Number: Enter the reference number of the case where the image is exported. This
number depends on how cases are named.
In Evidence Number: Enter the reference number of the piece of evidence where the image
is exported to. This number depends on the way evidence is named.
in Examiner: Enter the examiner for the case.
In Description: Enter a brief description of the images.
In Notes: Enter a brief note about the image.
In Model Number: Enter the number for the disk being exported.
In Serial Number: Enter the serial number of the device being exported.
In Verify image after writing: Select to have Nuix Imager verify the data after exporting.
3. Under Image Settings, complete details as follows:
a. In Compression Type: Select the type of compression to be used during the export:
® No Compression
® Fastest Compression (default setting)
® Smallest File Size
b. In Split Image into Segments: Select this check box to split the image.
c. In Segment Size: If you have selected the preceding option, then enter the size of each
segment. The default setting is 2GB.
The progress of the export appears, including the export rate (how fast the export is
occurring) and the estimated remaining time.
4. To view the current status of the binary template, click the arrow in the Current binary block.
On export completion, a confirmation message appears.
5. Click OK to exit the window.

@
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Alternatively, select the required item of evidence, right-click it and from a context menu, select Export
Disk Image.
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Export alogical image
To export a logical image of the evidence to an output directory:

1. In Nuix Imager, select the Export menu, and the Export Logical Image option.
2. Enter or select details as follows:
a. In Output Directory: Enter the directory where the output file is saved after export.
b. In Image Base Name: Enter a name for the image export is populated by default. Update the
name, if required.
c. In Case Number: Enter the reference number of the case you are exporting the image to.
d. In Evidence Number: Enter the reference number of the piece of evidence you are exporting
the image to.
In Examiner: Enter the examiner for the case.
In Description: Enter a brief description of the image.
In Notes: Enter a brief note about the image.
In Compression: Select one of these compression types to use during the export:
- No Compression
- Fastest Compression (default setting)
- Smallest File Size
3. To view the current status of the binary template, click the arrow in the Current binary block.
On export completion, a confirmation message appears.
4. Click OK to exit the window.

TQ o

Alternatively, select the required item of evidence, right-click it and from a context menu, select Export
Logical Image.

See Take a Nuix logical image for other information.

Export items of evidence as areport or digest

To export items of the evidence to a selected directory as a report or a digest type:

1. In Nuix Imager, select the Export menu, and the Export Items option.
2. Select one of the following options:

- Generate Item details report

- Compute MD5 digests

- Compute SHA-1 digest
3. Click OK to exit the window.

Export a list of evidence items as a report or digest

To export the list of evidence items to a selected directory as a report or a digest type:

1. In Nuix Imager, select the Export menu, and the Export Item List option.
2. Select one of the following options:

- Generate Item details report

- Compute MD5 digests

- Compute SHA-1 digest
3. Click OK to exit the window.
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View encrypted data by OS

This section explains full disk encryption by operating platform.

View encrypted data in a Windows OS

Adding a logical drive as evidence enables you to inspect an encrypted disk in the Windows OS.

For example, if C:// is encrypted using BitLocker, viewing the contents of \.\PhysicalDrive0 shows the
encrypted volume, but the file system is not readable.

Adding the logical drive C:// enables the contents of the file system to be read as long as Windows has
decrypted the volume.

View encrypted data in a macOS/FileVault

Under macOS, the kernel creates a second disk device for the unencrypted copy of a FileVault drive. For
example, if the original device is named rdisk0, then a device called rdiskl is created for the unencrypted
copy of the drive.

The device numbers do not have to be in sequential order. A device with the name rdisk3 may map to
rdisk6. Examining the serial number that is extracted into metadata from both top-level devices shows the

same serial and model numbers for both devices.
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Image mobile devices

Nuix Imager can be used to image mobile devices such as phones, tablets, and watches (Apple and
Android) to a logical image.

Prerequisites

To image an iOS or Android device, you must configure the device to trust the imaging computer.
To image an Android device, you must do a little more. Details follow in Image an Android device.

Set up iOS devices

While Nuix Imager can extract the Calls and SMS databases from iOS devices, the Nuix Workstation
engine does not currently support the decoding of the current database formats.

Nuix plans to support decoding of the latest Calls and SMS databases from iOS devices in a future release

of Nuix Imager. In the meantime, contact Nuix Support for a workaround, should you need this feature for
your iOS device extraction.

Image an iOS device

To image an iOS mobile device:

1. Select File > Image Mobile Device from the menu.
2. Select the device to be imaged and click Next.

Image Mobile Device

Choose Device Output File Device Photos Imaging Settings

Choose a device

Nuix Imager iPhone ) )
Device Information
iPhone 7 MN3H2
Platform
i0S 12.3.1

Device name: Nuix Imager iPhone

= device trusis host Device platform: iOS

Device vendor: Apple

Device model: iPhone 7

Device model number: MN9H2
Serial number: CEKS35SAHGTK
Device colour: 1

i0S UDID: 351a849376197101ba6e965143f8d90b4301271
i0S activation state: Activated

OS version: 12.3.1

©8 build version: 16F203

Password protected: false

Device time zone: America/New_York

= Refresh Devices

Can't see a device?

Connectivity

IMEI: 359206070530191

IMSI: 310410635872014

ICCID: 89014103276358720149

Phone number:

Bluetooth MAC address: b8:53:ac.04:17:62
Ethernet MAC address: b&:53'ac 041764
Wifi MAC address: b3 53:ac:04:17:62
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3. Enter the details in the output file and click Next.

Image Mabile Device

Choose Device Qutput File Device Photos Imaging Settings

QOutput File
Qutput folder:

C\Users\Admin\Documents\Worker Temp

Image base name:

Apple-iPhone 7

Case number:

Case 1234

Evidence number:
456
Investigator:

John SMith

Description:

Nuix Imager's iPhone]

Notes:

Back Next

4. Take a photo of the device using the webcam, upload it to the Device Photos tab, and click Next.

Image Mobile Device

Choose Device Output File Device Photos Imaging Settings

Device Photos

Use your webcam here to take photos of the mobile device to record against the logical image, to aid identification later on

Lal

Back Next

5. Onthe Imaging Settings tab, select Image via Agent, and click Start Imaging.
6. On completion, the newly created image automatically opens for you to inspect the result of the

imaging Brocess.

cortogeaimge. B ConoueDgess @ ey e

Nuix Imager iPhone
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Set up an Android device

To set up an Android device:

1. Ensure the Android Debug Bridge (ADB) drivers are installed on the Windows computer for the
Android device.

2. Navigate to Settings, select About Phone/About Device > Software Info, and tap the build
number (as if it were a button) until developer mode is enabled.
This normally takes about five to seven times.

3. Navigate to Settings, then go into Developer Options and enable USB debugging.

4. For first-time connections only, the following message appears:
'Allow connections from a computer being used for USB debugging on the Android device being set
up.'
This message continues to appear unless you select Always Trust. The location of this setting can
vary with the manufacturer or OS version of the device.

Note: Due to the many different versions of available Android devices, the preceding procedure may vary
by Operating System and device. The amount of data extracted will also be impacted by these factors.

Image an Android device

Before you image an Android device, you must do the following:

1. Under Developer Options, enable USB debugging.
2. Unlock it so that it can to perform a full backup of the phone.

To image an Android device:

1. Select Image Mobile Device from the menu or the main toolbar.

TR —

ey Trepr—" y—r—y—

2. Select the device to be imaged and click Next.
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3. Enter the details in the output file and click Next.

Choose a device

mage oode Deves

mageg Setrgs

RN

Output Fils

S
e —— =

Image base rame:
Somy 8811

Gave rumber:

Evidence mumter;

investigator:

Descrigtion:

Moz [ tm

4. Optionally, take a photo of the device using the webcam and upload it to the Device Photos tab,

or take screenshots of data that cannot be obtained by imaging the device; and click Next.
LR image Mobile Device

Choose Device Device Photos

Output File Imaging Settings

Device Photos
Use your webcam here to take photos of the mobile device to record against the logical image, to aid identification later on.

e

Device Screenshots
Capture screenshots from the device of any data which cannot be directly obtained via imaging the device.

s

Bock gt

5. On the Imaging Settings tab, select one or more of these options: Perform a backup, Image
filesystem, or Image via agent.
6. Click Start Imaging to start imaging the device.

Note: Your device's media transfer protocol (MTP) interface may yield some additional data. Image
this interface to ensure that data is captured.

7. On completion, the newly created image automatically opens for you to inspect the result of the
imaging process.
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Take a Nuix logical image

The format of the Nuix logical image has two main components:

* An EDRM XML load file: This contains the metadata and integrity, and checks for an image.

® A ZIP container: This contains the EDRM load file and all image data.

The ZIP file is used to store a loosely representative structure of the original data. This structure does
not have to match the high-fidelity structure stored in the load file. Similarly, the created, accessed,
and modified times may be set on the ZIP entries, but again this is just a display detail for native
clients. The actual metadata for an item is stored with the associated document in the EDRM load file.

The following example displays a logical image opened with Nuix Imager, and then the same image

opened with 7-Zip.

Evidence Tree [EIE 4
=1~ ] directories-and-files.zip
Evidence 2
duplicate-names.dd
duplicats-names
[File Syskem Raat]

jesse
A [ &= jane.ipg
- [ [& jesse-jane.ipg
#- ] [ jesse.dpg

= jesse
¥ & jesse-mugshot.jpg. webp
+ F jesse-acidpour.png. webp
- [] @ saul.webp

+- ||| M gus.png

| e Qus.png

File  Edit View Favorites Tools Help

N L

Add  Extract Test Copy Move Delete Info

T Enuis-trunkdtest- datahdiskimages\edrmzip\directaries-and-files.ziph

Exnuix-trunkd\test-dataidiskimages\edrmzipidirectories-and-filesziph

Evidence 2yduplicats-names. ddy,
Evidence 2yduplicate-narmes. dd\duplicate-namesy
Evidence 2hduplicate-names dd\duplicate-namesi[File Systern Root]y

Path Prefix Mame
+ f : » . tadat:
Logicial image metadata and integrity checks
- - Evidence 2 |
Evidence 24

duplicate-narmes.dd
duplicate-names
[File Systern Root]
jesse

_rmetadatat, [ Timage_contents.shal_hash
._metadatal, Ig'\mageicontents‘xml
\_metadata’ L_:i-\mage_metadata.xm\

Evidence 2hduplicate-narnes. ddiduplicate-narnesi[File System Root]y

Evidence 2hduplicate-names. ddiduplicate-namesh[File Systern Root]y

Evidence Zyduplicate-names.dd\duplicate-names\[File System Roat]yjesse’,
Evidence 2hduplicate-names dd\duplicate-narmes\[File Systermn Rootlyjessel,
Evidence 2vduplicate-names ddiduplicate-namesi[File System Root]yjessel
Evidence 2yduplicate-nares. ddiduplicate-narnesy[File System Root]yjessel
Evidence 2hduplicate-names. dd\duplicate-narmes\[File Systermn Rootlyjessel
Evidence 2yduplicate-names.ddiduplicate-names\[File System Roat]jessel,

<

R/ qus.png

Bl gus_1.png

=/ jane.jng

& jesse-acidpour.pngawebp
= jesse-jane.jpg

€ jesse-rnugshotjpgavebp
= jessejpg

@ saulwebp

Size

0
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Packed Size
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16353
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Modified
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2015-06-12 10008
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2015-06-12 10:08
2015-06-12 10:03
2015-06-12 10:10

>

Qobject(s) selected

Note:

7-Zip places all images into the same directories, but Nuix Imager separates them.

Due to limitations in the ZIP format, duplicate folder names are not allowed. This can occur with NTFS

images that include deleted data.
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ZIP container

When a logical image is exported, an .nli (Nuix Logical Image) file is created in the location that was
selected before starting the export. The image file created by Nuix Imager is a standard ZIP64 container.
Any standard ZIP container can be a valid container for a Nuix Logical Image.

Metadata directory

Contained in the generated .nli image, the ._metadata directory contains the logical image metadata and
integrity checks generated during the export. Any non-standard third-party extensions are also placed in
this directory.

A subset of the EDRM XML version 1.2 standard is used to store the metadata, structure, and integrity
checks for the documents included in the image and their associated binaries.

Documents

The native path specified for an item is the key used to locate that item's binary inside the ZIP file. The
Location URI value specifies the path to an item inside the data tree of a load file.

Note:

Two different directory targets can share the same name. This is shown in the example provided at the
beginning of this section.

Evi dence 2/dupli cate-nanes. dd/ dupl i cate-nanmes/[File System Root]/jesse.

In the event of duplication, the load file uses the Folders element to resolve the actual file structure.

Restrictions

® Only one single Native file is allowed per document.
* No other files are allowed to be specified (text, PDF, TIFF, and so on).
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Troubleshooting issues

This section shows where the Nuix Imager logs reside in a default installation and how to collect them for
self-analysis or to send through to Nuix Support.

It is good practice to always attempt to troubleshoot an issue yourself. Nuix suggests you do so by doing
the following, in this order:

1. Goto the Log Directory locations to find the latest log files to see what they contain.
2. Access the System Diagnostics, and possibly generate a diagnostic dump.
3. If you cannot resolve the issue, and need assistance, then:
a. Return to the latest log folder and zip the entire folder including the time-stamped name of
root folder
b. Submit a ticket with a description of the issue on the Nuix Support Portal, located at
https://nuix.service-now.com/support.
If you do not have an account for the Nuix Support Portal, you can request one on the site.

Log directory locations

Nuix Imager produces detailed logs that can help you identify the cause of issues. When requesting
support, always save the logs through System Diagnostics. You can find the full set of logs for your current
and previous sessions in their default installation locations. Each time you start Nuix Imager, a new
session is created with a new set of logs. Each session has its own time-stamped folder in the default
location for your operating system, as detailed in the following table:

Operating System Log Location
Windows Navigate to ~\Users\[Current User]\AppData\Local\Nuix\Logs

macOS Open the Console.app. The logs appear under ~/Library/Logs/«app name»
Linux Navigate to ~/.nuix/logs/

Alternatively, select Help > Open Log Directory within the application to navigate the Logs folder.

Generate a diagnostic dump

Nuix Imager produces a package of diagnostic information to help troubleshoot any issue. This package
contains the logs from the currently open session/case and information regarding the environment, but no
actual data from the case.

Note: To redact any sensitive information out of Nuix logs or files from the diagnostics, do not remove the
information from these files. Instead, replace the sensitive words or paths with some special characters, for
example, xxxxxx. This leaves the log structure intact, which in some cases is very important when reading
it as the actual information.

1. To access system diagnostics, click Help > System Diagnostics.
2. Click Save to File and browse the path to save the diagnostics package.
A zip file downloads containing logs and a variety of artifacts to help troubleshoot your issue.
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